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Business Objects Desktop Intelligence Custom Reporting

Prerequisites
You should have completed the following before continuing:
e eMARS 101 Introduction to eMARS
e eMARS 111 Chart of Accounts/Budget and Cash Control
e 1102 eMARS Introduction to infoAdvantage: Standard Reporting
e 1112 eMARS InfoAdvantage Custom Reporting
e Desktop Intelligence Software
o Installed and functioning (on your local machine)
o Password assigned (by Customer Resource Center)
o Obtained Named User License (no sharing of software)

Objective

The Standard Reporting course will give you a thorough understanding of Business Objects and
expose you to various functions that may aid in your custom reporting needs.

At the conclusion of this session, you will be able to:

e Log into Desktop Intelligence

e Understand Universes and Data Providers

e Define Toolbars in the Query Panel and Report Panel

e Create and Run Queries

e Apply Conditions, Prompts and Filters to Queries and Reports
e Apply Formatting such as Sections and Breaks

e Understand Formulas and Variables

e Join Multiple Data Providers (Two or More Universes, Two or More Queries on one Universe)
e Understand Drill Down and Scope of Analysis

e Understand Combine Queries (Union, Minus, and Intersect)

e Understand Crosstab Queries

e Retrieve and Edit a Statewide Report

Instructor Led Course

This course is taught over three days and presented in a computer lab or training room with an
instructor and one or more facilitators. The instructor will present the information by walking students
through the training manual and completing the examples in each chapter on the screen. The students
in the class will follow by doing the same steps as the instructor. The students will be asked to
complete exercises containing review questions about the material covered and hands-on exercises at
various intervals throughout the course.
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Training Data

Various Universes will be used in this course. Training IDs are provided with access to Department
785, Finance Facilities data, with permission from the agency.

General Overview

Business Objects Desktop Intelligence (referred to as “Desktop Intelligence” throughout this training
manual) is a reporting tool that is used to create simple and complex reports. It is an application that
allows people to access and format information stored in databases and other data sources. Along with
the delivered reports, Desktop Intelligence includes advanced functions to facilitate easy building and
editing of custom queries as well as manipulating the report layout, data display, and presentation of a
custom report.

Desktop Intelligence differs from infoAdvantage/Webl in that you must purchase a license and have the
software installed on your computer. This course will review your previous understanding of Universes
and expose you to the many functions that can aide in your custom reporting needs.

InfoAdvantage Universes point to data warehouse tables that are updated each night using an Extract,
Transform and Load (ETL) process. The data warehouse reflects data from the previous business day,
which is loaded to the data warehouse during the eMARS Nightly Cycle.

It is important to note that users should always check the eMARS News & Alert web site @
http://mars.ky.gov/alerts/marsnewsalerts.htm each morning to verify that the ETL process has
completed and that the data warehouse is ready for reporting. Usually, if the ETL process has not
completed, you will not be able to log into Desktop Intelligence; however, the possibility exists for an
exception to occur and infoAdvantage may be accessible even if the data warehouse has not been
completely updated.
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Chapter 1: Getting Started
Opening Desktop Intelligence

To open Desktop Intelligence

1. Click on Start/Programs/Business Objects Xl 3.1/Business Objects Enterprise Client
Tools/Desktop Intelligence

NOTE: The version of
Business Objects may
change from XI 3.1 to
a higher version in the
future.

You will be prompted to input your User Name and
Password. Logging into Desktop Intelligence identifies you
to the system allowing you to access features, open reports,
or retrieve inbox documents that are available to your profile.

The  Customer  Resource
Center must initially set up [ReEeBEUUILEIEL
your password once the
software has been installed.

—Y

o Business Objects’
2. To log in, simply enter a System,
User Name, Password, and .
. . . Enker wour name and password ko log in.
Authentication. For  training
purposes, Training IDs and S [kyeasxboxin64an El

Passwords will be supplied by your
instructor. Remember passwords are
case sensitive.

User Mame: | Train3

Password: |
NOTE: The generic User Name and
Password that you use during training Authentication Enterprise ~|
will not be valid after the conclusion of
each class. This has been set up

primarily for use in this class. Ok, | Cancel | Help |

[ Use in OFfline Made

3. Next, Click the OK button.

CAUTION: If you attempt to log in fails on a number of consecutive occasions, you will lock out
your account. You only have three (3) tries. You cannot log in again until a Supervisor has reset
your password. Please email the Customer Resource Center @ Finance.CRCGroup@ky.gov to
have you account unlocked.

Use in Offline Mode

This option allows reports that have been saved to your local computer to be opened, even when the
network is down. You will not be able to retrieve, publish or send reports, but you may be able to
refresh them with the latest data that has been stored on your computer.

The Use in Offline Mode option should only be used when the network is down or when the computer is
not attached to the network. When reports are refreshed, Desktop Intelligence checks to see if there
are any new changes to the way the data is to be retrieved; if there are any changes, then Desktop
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Intelligence downloads the new instructions to your machine. However, if the Use in Offline Mode
option has been checked, Desktop Intelligence can not check for these changes.

Selecting a Data Provider

After you log in to Desktop Intelligence, the New Report Wizard should display. You use this wizard
when creating new reports. If you are retrieving a report from the repository or opening a report from
your computer, you may click on the Cancel button to exit the wizard.

NOTE: You may uncheck the Run this Wizard at Startup option that is located in the lower left
corner of the wizard panel if you do not want the wizard to automatically start when you log in to
Desktop Intelligence. Leave this boxed checked if you want the wizard to be displayed when the
application is first opened.

4. Click on Generate a Standard Report

Welcome

This wizard helps wou create a new repart, To open an exisking
document, click Cancel and select the Open command from the

& For the report layout, you can:
{* Generate a standard report

" Select a template

Click Begin to specify how to access data

[w Fun this Wizard at Startup Begin = Cancel

5. Click on Begin >.

Once you have clicked on Begin >, the wizard will move to the Specify Data Access
section of the wizard. This next step will allow you to choose which type of Data
Provider to use in your report.
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Next, we want to Select the way you want to access data. You have several options to choose from.

Mew Report Wizard

Universe will allow you to choose from a

list of Universes that are available and that
point to data in the Reporting Data

-’ ways ko access the data you want o work with.
Warehouse.

| (* Universe
. Use a Desktop Inteligence universe to choose the
6_ Select Unlverse i daka to display in a report,
" Others
. . Personal data files j
7' CIICk NeXt > to see a IISt Use an Excel, dBase or ASCII file to retrieve data
and display it in a report

of Universes.

Specify Data Access

‘ith Desktop Inteligence, wou can work with corporate
data, as well as with personal data. There are different

& Select the way you want to access data:

< Back | Mext = | Cancel |

Others will allow you to choose from a list of data providers outside the Universes. Depending on the
software installation, “other” options will vary. Some examples include:

Mew Report Wizard

Specify Data Access

ith Desktop Inteligence, wou can work with corporate
data, as well as with personal data. There are different

m ways ko access the data you wank ko work with,

# Select the way you want bo access data:

" Uriverse
Use a Desktop Inteligence universe to choose the
— daka ko display in a repart.

* Others

Personal data files ﬂ

SML Data Provider
Vizual Basic For Applications procedures
Personal data files

< Back | Finish | Cancel

Visual Basic for Applications procedures
are special programs developed within the
BO document.

Personal data files are files that are stored
on your computer such as an Excel File.

9of227



Ke

eMAR

eMARS Desktop Intelligence Reporting

After you click on Universe then click Finish, the New Report Wizard screen will appear and provide a
list of Available Universes.

Mew Report Wizard

Select a Universe

To access universe data, select a universe,

Fixed Assets ”

Gaeographic Location
Inventaory —
Island Resorts Marketing
| k' Capital Projects
__| EN-CO8
£ [

[ Set as My Defaulk Universe

(%

Help on the selected universe;

< Back ‘ Finish | Cancel

8. Click on the General Accounting universe.
9. Click on Finish. The wizard panel will disappear and the Query Panel will appear.
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Chapter 2: Universes

What is a Universe
A Universe is a database interface that maps objects to fields in a database or a grouping of tables. It
provides an easy to use interface for users to run queries against a database to create reports and

perform data analysis.
The Universe simplifies the report creation process by eliminating the need to know the database
structure or be a relational database expert. It also provides automatic joins between database tables.

Below is an example of a Universe with all the tables joined together. The multiple boxes represent tables and
the lines are joins between the tables. See Appendix F Primary Verses Kernel Universes.
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The Universe appears in the Query Panel to the left of the Result Objects and Conditions panels.

‘R Query Panel - General Accounting Universe

|_$7'.'? Y3 |ScopeoFF\naIvsis:None j TH %-‘ B 2? @

Classes and Objects Result Objects

B
1| Fiscal Year
1| Budget Fiscal Year
[=}12= O - Fund Accounting
=== Fund
| Fund
! sub-Fund
Close inta Account
| Capital Asset Fund
Responsibility Center Posting Flag >
Crerd Responsibility Ctr Post Flag A A
| Master Bark Account Universe ObleCts
b Master Bank Mame
b Master Bank Mumber
b Master Bank Account Mumber — -~ -
A8 Fund hisrarchy To apply a condition, drag an object to this pane.
| CAFR. Fund
| Cbject
| Revenue
.| Balance Sheet Account /
| Departrment Object
| Department Revenue
1| COA - Organization
| COA - Detailled Accounting
L COA - Budgeting
1| Bank,

CECR |

COptions., .. 5 l | | Cancel

|

TN'nsert an object in the query, open a class folder then double-click the obhject.

11

Condfions

E-E-E-E-E

& E-E

%
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Classes and Objects

A Universe is a collection of Universe Objects. Universe Objects represent fields in a database table.
The object names will be everyday terms instead of the cryptic field names in a database. Related
Universe Objects are grouped into Classes.

Classes — Folders

Classes are logical groupings of Universe Objects. For example, all address fields might be grouped
together in one Class.

Universe Objects

There are three different types of Universe Objects: Dimension, Detail and Measure.

Different types of universe objects

=

Forward Ref Documnent
Accounting Journal
Pstng Armounk
Debit Amount
Credit Amount
= Posting Details
Line Funckion
Posting Line Mumber
Dehit/Credit Flag
Accounting Line Description
Document Run Date
Dacument Run Tirme
= Docurment Record Dake
¥ Document Record Month
b Document Record Year
¥ Document Record Day
Posting Pair Type

Dimension Objects ( " ) — Blue Diamond

These objects are either text or dates, such as Fiscal Year or
Document Record Date. Dimensions represent the basic
structure of the data.

Detail Objects ( #) — Green Pyramid

Always associated with a dimension object and provides
additional descriptive data about that dimension. Details such as
Start Date, End Date and Closed Flag are objects that could be
related to a Fiscal Year Dimension.

Measure Object (**) — Orange Ruler

Always represents numeric data that is the result of calculations
on data in the database. A measure’s value changes depending
on the context of the report. For example, the Pstng Amount will
differ depending on the Closing Classification, Posting Code or if
the report is for one Accounting Period or multiple periods.

Predefined Conditions

fccounting Period

Predefined Filter ( I") — Yellow Funnel

{ Optional &s OF Actg Period Prompt | Special kind of object that may be added to reports to restrict
{ Cptional Accounting Perind Prompt | data that is returned. Information is limited to defined values.
{ Required Accounting Perind Prompt | They are created by a Universe Designer for conditions that
{ Required Multi Ackg Period Prompt. | @re complicated and/or commonly used. There are

Required &s OF Actg Preiod Pro predefined filters, custom filters and prompts. An example of
~ & *H a filter is Required Accounting Period Prompt.

NOTE: In Desktop Intelligence, to view the Predefined Filters, you must Click
on the Filter icon radio button at the bottom of the Query Panel.
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Chapter 3: Creating a Report
Creating a report consists of
e Building the query by dragging and dropping objects from the Universe into the Result Objects
Panel
e Adding filters, if desired
e Setting the Scope of Analysis, if creating a Drill Down report
e Managing query properties
e Running the query

A query is one or more statements designed to answer a business question that requires data from a
database. In other words, the query is a means to ask the database for information.

When the query is run, the request for information is processed in the database, and if the data is
available, the results are sent back to the report panel in the form of a table which contains rows and
columns.

The Query Process

CLIENT | SERVER
|
|
User |
|
S
|
|
|
5 |
ata ‘ 1
Provider I
[ InfoAdvantage
I Warehouse
|
|
|
Report I
1
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Query Panel (also referred to as the Data Provider)

The Query Panel displays all of the objects that are available in a Universe. When the query is ready to
be built, select the Dimension and Detail Objects from the Universe that represent the information that
you want to retrieve, and drag them to the Result Objects panel. Add Measure Objects that represent
the calculation, or the action that you want to perform on the information.

‘W Query Panel - General Accounting Universe Z”‘szl
’? '.? |Scu:u|:ue of Analysis: Mone ﬂ i ‘%—'l |2{f| | @
Classes and Objecks Resulk Objecks

g A To insert an object in the query, open a class folder then
|| Fiscal Year

double-click the object.
|| Budget Fiscal Year

L Oy - Fund Accounting
| CO - Crganization

| COA - Detailed Accounting

_____ | v - Budgeting Classes and Results Objects
~ | Bank Objects Panel

|| Event Tvpe Panel

|| Posting Code

L | Dacurmenk

|| Backward Ref Document
|| Forward Ref Document

| Accounting Journal o
Conditions

To apply a condition, drag an object to this pane.

| Detailed Accounting Ledger
|| Created from User Objects

o 3 A R B 3 e R o 3 R B B 3 e B 3 R R R 3 R e R |

| CO8 - Cost Accounting Conditions
1| vendor Customer Headquarters Panel
T mrnrnmdibeo \f
oo )

Cptions. .. | | Cancel

2 Show/Hide All Classes it View SQL
A

| ;? Show/Hide Help o User Objects

(

Wrap Result Objects 9 Combine Queries

v Simple Condition I:E | Help

A

Zl

E Sort Rk O

Show all Objects and Classes
and
Show All Predefined Conditions

Scope of Analysis

[ H
—

Manage Sorts
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The search feature is an extremely handy tool. There may be times when there are too many objects in
the Query Panel and it is difficult to find an object of interest.

To use the search feature start typing the object name and the object will be
ﬂﬁ| Search highlighted in the Classes and Objects Panel. Each time you hit enter you
will be taken to each object that has the search word in the name.

NOTE: Use caution when using the search feature. Some universes may contain objects in more
than one class that is located on more than one database table. Using the wrong object could
cause undesirable results in your reports.

Query OptiOﬂS opkions. ..

Row Options:
Thg defgult setting for tr_ns. option is Duplicate Rows. Query Options
This option puts no restriction on the data returned by
the query Raws Partial Resulks
’ Your query can return duplicate rows, &+ Default Yalue
The other setting is No Duplicate Rows. This option BOEY SELS 10 Rows
tells the query to retrieve only distinct combinations & Duplicate Rows 20 Rows
of row values. It is important not to use this option " Mo Duplicate Raws " Other
with queries that do have summary measures (i.e. _
Posting Amount) in the Result Objects window, | DoMNetRetrievsData
because it may force the query to return incorrect | I Delste TraiingBlanks ok | cancel Help
information.

Partial Results Options:

This section allows the number of rows returned by the query to be limited to a defined number of rows.
We use this option for several reasons. One reason is that we may want to limit the rows returned to a
report when we are creating and testing it. The reason for this is that if we did not limit the rows, the
report may retrieve thousands of rows and make testing more difficult. Once testing has been
completed and the report is ready to be released, simply set the option back to default, which places no
limitation on the number of rows returned.

Do Not Retrieve Data Option:

This option allows you to exit the Query Panel by clicking the Run button without running the query.
This option does the same thing as Save and Close. It closes the query without running it so that the
query may be saved.

Delete Trailing Blanks Option:

This option deletes trailing spaces from rows that are padded in order to make all rows the same
length. This option keeps the extra spaces from taking up memory and helps the query run faster.
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Save and Cloze Wigw, .. Bun Cancel

Save and Close: Closes the query, saves all changes, purges data from your report, and does not run
the query.

View: Results are displayed in the Data Manager to be viewed and accepted before the data is
presented in the report.

Run: Executes the current query and returns data to the report. The first time it is run, it will create a
new report. If it is run after objects have been removed or added, the report will be modified when run
again. However, if the report contains more than one table, Desktop Intelligence will ask if the report
should be left as it is or if the changes should be displayed in the report.

Cancel: Dismisses the panel without running or saving the current query. Any changes made to the
existing query will not be saved and any new queries will not generate a report.

Building a Query

To build a query, simply find the object you want on your report and drag it in to the Result Objects
Panel.

‘A Query Panel - General Accounting Universe I:J E| g|
IE 2= |5CD|:|E aof Analysis: Mone j 53| B S&| z§|9| @
Classes and Objects Result Objects
.| Accounting Period ~
B Ficcal Yo Funu:l| ¥ Fund Name|
| Budget Fiscal Year
=12 CO4 - Fund Accounting NOTE: Be sure to drag
Bz Fnd Drag and drop into Objects onto your report
B0 Results Objects Panel | and not the entire folder.
b Fund Mame

If you drag the entire

:Ez:jg;::::puon folder, all the objects in
b Active Flag that folder will be moved
b Fund Contact Code Conditions to the Result Objects
P Fund Conkack First Mame Panel.

Fund In list '0100,01AF,0301

F Fund Contact Middle Narme
¥ Fund Contact Last Mame

b Fund Contact Prefix Marme Drag Fund into the

b Fund Contack Suffix Mame Conditions Panel.

¥ Find Cantart Pasitinn ! Choose “In List” and
select 0100, 01AP, 0301.

ek o @

Save and Close | Wigw, ,, ‘ Run | Cancel |

10. Locate and drag Fund and Fund Name from under the COA — Fund Accounting Class
to the Result Objects Panel.
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When building a condition in a query, you
need to

e Find the object you wish to
build a condition on.

e Drag the object to the
Conditions Panel.

e Select the operator (Equal to,
Different from, In list, etc.).

e Select the operand (Type a
new constant, Show list of
values, Type a new prompt,
etc) from the list of
Operands.

11. Drag Fund into the Conditions Panel.

Conditions

SN ll<Select an operakor =

12. From the list of Operators choose In List.

Conditions

SNl [l <5elect an operand bype

13. From the list of Operands choose Show List of Values and select 0100,

Dperators

Equal to

Cifferent from
Greater than

Greater than or equal to
Less than

Less than ar equal ko
Between

hok between

In lisk

Mot in lisk

Is null

Is ok null

Matches pattern
Different from patkern
Both

Except

Operands

Type a new constant
Show list of values
Type a new prompk
Show list of prompts
Select an object
Create a subguery
Calculation

Select Query Resulks

Fund In list '0100,01AP,0301'

01AP and 0301 from the list.

List of Values of Fur

S== [+ Tabular Yiew

Fund

HINT: Holding the CTRL key down will allow you to select one Fund at a
time. Holding the Shift key down while clicking on Fund 0100 and then
Fund 0301 will allow you to select all Funds in between (01AP, 01NE).

OME
Mz

. . 0302
14. Click Run fun to create the report once you have the objects and

conditions that you need.
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Report Panel

After clicking on Run in the Query Panel, you should have something similar to the figure below. If you
notice, the report contains the objects that we moved into the Result Objects Panel. As well, the report
only returned those Funds that we selected in the Conditions Panel (0100, 01AP, 0301).

£ Desktop Intelligence - Document1 - [PYT0013 - ekyadvhoxi3: 6400]

CEX

aj File Edit “iew Insert Formak Tools Data  Analysis  Window Help =] x|
Ll sk i ABES®m3|Eaql|we -
il -
s Data l Map ] Report Title
—|-{==" Wariahles
I Fund
Fund Fund Name
b Fund Mame
Farmulas 0100 General Fund
01AR Abandoned Propg
0301 Adair County Deb
‘ f
G&' F@ %Reportl
Last Exec: 3/2502009 1:17 UM

Now, let’s review some features of the report
panel.

First, let’s turn on some Toolbars that you will use
fairly often when formatting a report.

15. Click on View then Toolbars.

The five Toolbars that are most commonly
used are:

o Structure
o Standard
o Formatting
o Report

o Formula

16. Check each of the five toolbars listed
above.

17. Click on Close.

Toolbars

[]Baorders

Standard Help
Forrnakhing

Report

[[]5arts

[] charts

[] Docurment Exchange

[ aligrirnent

Forraula

[] Wisual Basic

[ Large Buttons
[+ Show Shorbcut Keys in Toolkips
v Show Toaoltips
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Your Report Panel should now look something like this:

QJ File Edit Yew Insert Format Tools Data  Anakysis  Window  He

EEX
=181

Lbed g i ESEmB | =aq|wee -
| ||| =] B £ D : B % » l0e0|EE =
A i =[5 | T = N oab g Er D
A |
| =
2% Data | [ Map | Report Title [
=I-{:= Wariables
b Fund Name
Farmulas 0100 General Fund
AP Abandoned Property Fund
0z01 Adair County Debt Service Fund
[« | _>H
Gfl F@ %Repurtl
Last Exec: 3f25/2009 1:17 MM
o F_II A These four icons are the ones that you will utilize most often.
w * Data lMap ]
EE' The Report Manager icon will hide/unhide your ||= ”‘?”‘3':"‘3;
: list of objects shown on the left side of the P E"'”dN
LN arne
report panel ve.
eport panel above Formulas 0100
If you turn this off, Data and Map are hidden and you |P]ﬂT
have more space to work on formatting your report.
ES'I F@ %REpurtl

ﬂ The Refresh icon refreshes the report.

you choose which query you want to edit if you have more than one data provider.

The Data Manager (Rubik’s Cube) icon brings up the Data Manager screen.

@ The Edit Data Provider icon takes you back to your query if you have one data provider or lets
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Data Manager

The Data Manager is divided into two tabs — the Results tab and the Definition tab. It also contains a
Data Providers section. The Data Providers section lists all of the Data Providers that you are using in
your report. Edit and Delete are two buttons below the Data Providers section. Edit will take you back
to the query panel so you may edit your data provider and Delete will actually delete the Data Provider
from your report.

NOTE: Before you Delete a Data Provider from the Data Manager, you should be sure to Purge
the data. Otherwise, the data forever stays within the report unseen, which makes your saved
report larger than it needs to be.

Data Manager @J
Diaka Providers Results ] Definition l
E- s tguerv 1 with General fu
Fund
P Fund Mame Fund Fund Marne
0100 General Fund
0100 General Fund
0100 General Fund
0100 General Fund
0LlAP Abandoned Pro...
0l4P Abandoned Pro...
0LlAP abandoned Pro...
0LlAP Abandoned Pro...
0301 Adair County D,
0301 Adair County D,
0301 adair County D,
0301 Adair County D,
¢ Y < >
Edit... Delete Options... | Refresh | Purge | Export.., |
QK | Cancel | Help |

The Results section displays the exact data returned by the selected data provider, which can differ
from the information displayed on the report. The data displayed here is raw data.

Below the Results section are four buttons that allow you to manipulate the data is some way.

Options: Will display the same options box that is available in the Query Panel that was
covered earlier. If you make changes here, the changes will not be displayed until
you Refresh the Data Manager.

Refresh: Will refresh the selected Data Provider. This will allow you to review data without
refreshing all Data Providers in your report.

Purge: Allows all of the data in a Data Provider to be removed from the report. Before
publishing a report, it is important to Purge all the Data Providers and then save.
This will make the file size of the report smaller and will take up less space in the
repository.

Export: The Export button allows you to export the data from the Data Providers. The data
will be exported exactly as it appears in the Data Manager and not as it appears on
the report. Using the simple report we created using Fund and Fund Name.
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18. To export the data in the Data Manager to your desktop, click Export

19. Click Browse
EporttoEsternalFormat |

You can zelect the farmat and the location for the data pou want ta

export.

— Format
% Export to Local File Format
|C:\Documents and Settings’

MHame:

;I [v DOS Format

Format: ITe:-tt Filez [*.azc; = prm; = tat; * cav]

Delimiter: ITabuIation 'I ||_
" Export o EDEMS
;I annection...l

LConnection; I

" Copyto DDE

v Delste Spaces
Ok Cancel Help

20. Change the file path to your Desktop.
21. Select Microsoft Excel Files as the file type.

i g

22, Click Save.

xpott to local file format
-

Save in: I @ Desklop

1My Documents

»_-J My Computer

\EJ My Mebwork Places
_IMARS Applications

I Save

File name: |Guel_l,l1
4| Cancel |

Save as vpe: IMicrosoﬂ Excel Files [*.xls]

All Files [*.7]
| Test Files

hicrosaft EHE;E| 97 Files [.xlz)
HhL Files [*.2ml]

After you click Save you will be taken back to the Export to External Format Screen (above).
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23. Click OK.

Desktop Intellipence

Export done!

K

You may now go to the Desktop and open up the file that you exported. When you open the Excel file

that you exported, it should resemble the Results section in the Data Manager:

EJ Microsoft Excel - Query1.XL5

@_] Fil=: Edit ‘“iew Insert Format  Tools Data  Window  H
RN RERE RS RN A N TN -N AR
F20 - &
....... A | B | C | D | E
s 1 [Fund Fund Name
I 2 (0100 General Fund
u 3 (0100 General Fund
ae | 4 0100 General Fund
| &5 [mn0o General Fund
= B |0MAF Abandoned Froperty Fund
= 7 |MAF Abandoned Froperty Fund
— | 8 [map Ahandaoned Property Fund
= | 3 |[MAP  Abandoned Property Fund
= | 10 (0301 Adair County Debt Service Fund
| 11 [0301 Adair County Debt Service Fund
$ 12 [03mM Adair County Debt Servdce Fund
% | 13 /0301 Adair County Debt Service Fund
. 14
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Definition: The next section in the Data Manager is the Definition Section. This section allows you to

view and define some of the attributes assigned to the data providers and the objects in

them.
Data Manager. E|
Daka Providers Results  Definition l
El-ga huery 1 with General Ac General [ Automatic Refresh
Fund Mame: -y o
P Fund Namme | Yuery 1 with General Accoun
Max Duration:
Max # Rows: From Date (Midivyyy)
v Editable j
[V Refreshable Time thh:mm:ss)
Universe: =
=
General Accounting J
Date | Time | # Rows | Dur atic
3fz5f2009 1:17:04 PM 12 o'
£ >
< >
Edit... Delete
oK | Cancel | Help |

Name: The Name edit field will allow you to change the name of the Data Provider. For example,
instead of keeping the name “Query 1 with General Accounting’, you could change it to “GA

UNIVERSE”.

Data Providers

B La E.ﬁ. LMIVERSE Genetal
Fund Mame:
b Fund Mare

Resylks  Definikion |

Universe: The Universe field allows the Uriverse:
universe for a report/query
to be changed.

-]

In order to change to a new universe, the new
universe must be compatible with the current
universe. This means that it must have fields that are
similar to the existing fields in the current data
provider. Once a universe has been changed, the
query must be refreshed to reflect the data that the
new universe is pointing to.

This field is most often used when promoting reports
from test universes to production.

| General Accounting

Change Universe

@ Select the universe on which you want ta run the query,

Universe

| Repasitary

File: Marne

ePay
Fixed Assets

Ireeentory
K¥ Canital Projects
<

Description

Document Phase Univ. ..

Geographic Location

[Universe
TUniverse
TUniverse
IUniverse
IUniverse
1l Iniverae

Document Phase Univ,

ePay

Fixed Assets
Geographic Location
Inventory

k¥ Canital Proiercts

~

v

[ ]

Cancel Help
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Data Providers: When you click on a particular object in the data provider, for instance, if you click on
Fund, the Definitions section will display the object’s definitions. The object Name and Type are
displayed. Fundis a Character Type.

Also, you can see that Fund is a Dimension object and not a Measure or a Detail. The Qualifications

are grayed out or disabled because you may not change the Qualification of an object in the Data
Manager.

This section is where you will go to Link data providers if you have multiple data providers. Linking, or
joining Universes, will be discussed later in the manual.

Data Manager E|
Daka Providers Results  Definition l
[E- B+ Ga UNIYERSE Data Description
m Mame: Type!
P Fund Mame | J
Gualification Yalues:

This iterm has the Fallowing qualification o100

for multidimensional analysis: QLAF

0301
o
~
p

Edit... Delete

(0] 4 | Cancel Help

The Structure icon will show you the Structure View of your report.

=NameOf{<Fund =HameOfi<Fund Hame>)
=<Fund= ==Fund Mame:=

NOTE: It is best practice to work in Structure View once you start making formatting changes to

your report. By doing so, you can easily identify changes you make to the structure of your table or
sections.

L

The Page Layout icon will show you the report header, footer and margins.
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Editing a Query

Scenario: Your boss has requested a report that shows Expenditures and Revenues to Date that
excludes General Fund and Capital Projects data. Instead of reinventing the wheel, you may make a
few modifications to the query we have already built.

To add, delete objects or modify conditions in your query you would:

24, Click the Edit Data Provider icon @ .

If you have multiple data providers you would select the one you want to edit. In this
instance, we only have one data provider so clicking the icon will be take you back to the
Query Panel.

Fund In list '0100,014P,0301"

25. Delete the condition:

26. In addition to Fund and Fund Name, drag the following objects into the Result Objects
Panel:

e Accounting Period > Fiscal Year

e Accounting Period > Accounting Period

e COA-Organization > Organization — Centralized View > Department

e COA-Organization > Organization — Centralized View > Department > Department Name
e Posting Code > Closing Classification

e Basic Accounting Ledger > Posting Amount

Result Objects

Fund F Fund Mame ‘

Fiscal Year Accounting F‘erin:u:l|

fif

Department ¥ Deparkment Mame |

Closing CIassiFicatil:nn| Posting F'.ml:uunl:|
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27. Before running the query, apply some Conditions so that only certain amount of information is

returned.
Conditions
Fund Type Mok in lisk 'DIIIII:IJIIIEI:II:I'| XJV1 eliminates Off
And
Posting Code Different From %1 |< BUdget Transfers
And from the report.
Closing Classification In list '10,11,14, 15" |

Fiscal Year Less than Prompt ('Enter Fiscal \’ear:'}|

Accounting Period Less than or equal ko Prompt {Enter Accounting Period: "

Fiscal Wear Equal ko Prompt ('Enker Fiscal ‘fear:']l|

NOTE: Double-click on a conjunction (AND or OR) to switch between the two values. Right-
click on a conjunction and choose Shift Left or Shift Right to rearrange conjunctions.

28. After applying the conditions, click on Save and Close
not run but will be saved prior to running it.

29. Save the report to your userDocs folder as Chapter3_Creating a Report—YourName.

30. Refresh 2 the report.
31. Enter the following information for the prompts:

Save and Cloze

Enter, or, Select Yalues El

Enter Accounting Period:
5

Enter Fizcal rear:

i

oK.

Cancel

Help

2008

U

Walues. ..
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32. Your table layout will be similar to the results shown below (after you rearrange the columns).

Based on the conditions we used in the query, you should see all Accounting Periods for Fiscal
Year 2007 and Accounting Periods 1 — 6 for Fiscal Year 2008.

Fiscal Year Accounting Peri Depariment Department Mamr Fund

Fund Name

Closing Posting Amount

2,007 .00 1.00(785 Facilities & Supp|132ZH  |Finance Facilities Se[14 -4 410.00
2007 .00 1.00(785 Facilities & Supp|132]  |Finance Federal Surg10 37 2ra09
200700 1.00 (785 Facilities & Supp132J Finance Federal Surg[11 0.00
2,007 .00 1.00(785 Facilities & Supp|132]  |Finance Federal Surp[14 -479 854,40
2,007 .00 1.00(785 Facilities & Supp|132K.  |Finance State Surplu[10 16,748.26
200700 1.00 (785 Facilities & Supp|132K  |Finance State Surplul1i 1,189.32
2,007 .00 1.00(785 Facilities & Supp|132K  |Finance State Surplu[14 -428 088 .97
2,007.00 1.00 735 Facilities & Suppl140%  [Fin-Fm Hist Propertie|14 -1025.00

33. Save your report again with data so that when you open it next time, you will not have to
refresh the report.

NOTE: When publishing or saving reports, it is best practice to purge all data from the report
and then save the report. If data needs to be kept in the report, first save the report as a PDF file
to a shared network location, then purge the report of data and save the report to Shared,
Personal or Inbox documents.

See Appendix C: Purging Data from Reports Prior to

Saving/Publishing for more information regarding purging reports.

34. Close your report and complete Exercise 1.
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Exercise 1: Creating a Report

Review
1) The data warehouse reflects data as of
a) The current business day
b) The previous business day

2) You have ___tries to log in to Desktop Intelligence before your account is locked out.
the CRC to have your account unlocked.

3) A universe is a collection of , Which represent fields in a
database.

4) Classes are of Universe Objects.

5) Name the three different types of Universe Objects:

a)
by ¥
c)
6) True or False Drag the folder of the object you want into the Result Objects Panel.

7) When building a condition in a query, you need to
a)
b)
c)
d)

8) Name the 4 most used icons in the Report Panel

69

a) b)
o & aq B
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Hands on Instructions

Task Overview

Use the General Accounting universe to create a simple report containing Expenditures and
Revenues.

For this exercise, you will create the query and report that will be the basis of a slightly more complex
report that you will create in future exercises.

This report will use prompts but we will retrieve data for Fiscal Year 2008 and Accounting Period 6
only.

Procedures

1) Open and log in to Desktop Intelligence.

2) When the New Report Wizard comes up, Click Generate a Standard Report.
3) Click on “Begin >”.

4) Click Universe for Select the way you want to access data.

5) Click “Next >”.

6) Select General Accounting Universe.

7) Click on “Finish’.

8) Drag the following objects into the Result Objects Panel.

Result Objecks

Fiscal Year

Accounting Period Fiscal Year ‘ focaunting P'eriu:u:l|
Department

Department Name Creparktment ¥ Department I"-.Iame|
Fund

Fund » Fund M
Fund Name N Hne ame
Object Object b Obiject Name

i

Object Name

Revenue Source Revenue Su:uuru:e| ¥ Revenue Source Mame
Revenue Source Name _

Posting Amount posting Amount|

NOTE: Remember to use the Posting Amount from the Basic Accounting Journal because you
are not pulling document level detail and you are not using Chart of Account elements such as
Activity, Function or Reporting in your query.
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9) Set up the following Conditions using And:
Accounting Period Equal to Prompt Enter Accounting Period:

And
Fiscal Year Equal to Prompt Enter Fiscal Year:
And
Fund Type Not in list 0700,0200
And
Posting Code Different from XJV1
And

Closing Classification In list 10,11,14,15

Conditions

Accounting Period Equal to Praompt ('Enter Accounting F‘eri-:u:l:']l| \
And
PROMPTS

Fiscal Year Equal ko Prompt ('Enter Fiscal "fear:']l| <
and

H

Fund Tvwpe kot in lisk 'EIIEIEIJEIZEIIZI'|

and
Posting Code Different from 'XJ'-.-'1'|

And
Closing Classification In lisk 10,11, 14, 15'|

Enter, or Select Values

10) Run the query and in the prompts input:
Enter Accounting Period:

a) Enter Accounting Period: 6 B

Cahicel

i

b) Enter Fiscal Year. 2008 Enter Fiscal Year: Help
|2008

Walues. ..

f

11) Your query should return a table layout similar to the figure below.

In order to fit the table on the page, Word Wrap was used on the headings. Your results will
look slightly different.

Revenue

Fiscal Year J;cc_l:unting Depar Department . Fund Object Object Rewvenue ¢ =~ Posting

eriod tment Name Name Name Source Name Amount
2,008.00 6.00 (7385 Facilities & S|132H |Finance I[E161  |Prison L 202.88
2,003.00 B.00|735 Facilities & Z|132H |Finance | Fa02 General Renta -229.00
2,008.00 B.00|735 Facilities & 5|132H |Finance | Fa04 General Fees -735.00
2,008.00 B.00|785 Facilities & 5{132J [Finance |E111  |Regular 16,045.95
2,008.00 5.00 (785 Facilities & £|132J |Finance [E121  |Employe 1,154.07
2,008.00 6.00 (7385 Facilities & S|1320 |Finance [E122 |Emp Re 1,363.92
2,008.00 5.00|785 Facilities & 5[132J [Finance |E123  |Employe 242408
2,008.00 5.00 (785 Facilities & £|1320 |Finance [E124  |Employe 11.16
2,008.00 B.00|785 Facilities & £|132J |Finance [E161  |Prison L g78.72

12) Save your report as Exercise1_ExpRevRpt—Your Name.
13) Close your report.
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Chapter 4: Simple Calculations

Desktop Intelligence has standard calculation | Data Analysis MWindow Help
functions that enable you to make quick [, ..., . :
calculations on the data in reports. These [ . EZ:EIF Es”l' AL
calculations are available directly from the menu |77 =™ e B % 5 %6
bar. The most commonly used caiculations are also || &1 Define as Variable...
. A A | |
available on the Report toolbar. T
Calculations. .. 2 E Sum
Z = H I i 1 Count
I Count Al
Euro , Average
Minirnun
¥4 Refresh Data Mazirmum
1 @ Edit Data Prowider. . #E Percentage
i Mew Data Provider ...
I Yiew Daka
To... Choose...
Calculate the sum of the selected data. Sum
Count all rows for a Measure object. Count
Count distinct values for a Dimension or Detalil
object.
Count the number of rows in the body including all Count All
duplicate and empty rows.
Calculate the average of the selected data. Average
Display the maximum value of the selected data. Maximum
Display the minimum value of the selected data. Minimum
Display the selected data as a percentage. Percentage
Calculate the difference between two selected Variance
values.
Calculate the difference between two selected values | Variance
and display it as a percentage. percentage
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Insert Sum

The Insert Sum Simple Calculation allows you to quickly calculate totals AT w11 ab
in your report. Click on the data in the field that you wish to sum and then :
click on the Insert Sum icon on the toolbar. Revenu e

Another method of inserting the sum would be to click on the data, right SR A
click, select Calculations, and then select Sum. Or you may select it from _ -

the menu bar under Data > Calculations. 202,58
S— General Renta
_ Seneral Fees

Calculation:s Sum:| J61.12

Yariables. ..
24 Bhzremgs Count Al
n4d fverage

Insert Percentage

Insert Percentage will quickly calculate the percentage of an amount that you have already summed.
Click on the data in the summed column and select Insert Percentage either from the toolbar, by right
clicking or by selecting it from Data > Calculations on the menu bar.

= A .. Calculations 2 E Sum
- : Tl Count
0 o LEEREgCyEs  Parcentane Yariables. ..
: Ame : Count Al
202 88 -26.66 % F'-'T-'g.rage
eneral Renta 30.09 % Mlﬂlr.ﬂum
eneral Fees 9557 % Maimur
Sum:| -761.12 Ew
Percent: 10000 %

Insert Count

Count will count all rows for a Measure Object, but only distinct values for a Dimension or Detail Object.
Count All will count the number of rows in the report including all duplicate and empty rows. For
example, if you return only 5 funds in a report but have 10 rows for each fund, Count will return 5
because it counts each Fund distinctively, but Count All will return 50 because it counts every instance

of Fund in the report.

Hn £
Click on data you wish to count, select Insert Count either from the
toolbar, by right clicking or by selecting from Data > Calculations on the Y= insert Court jds
menu bar. 3 _
Tl Ot ol T Lir1 E161 Prison L
Zalculations R402
Hn
Yariables. ., count: Al
aun
AU EZTZ[IVIEIN = o >
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Ranking

Ranking enables you to look at the largest and smallest numbers in a report. Like filtering, it hides the
data you do not want to display. Desktop Intelligence does not delete the data from the report; you can
view it again whenever you like by removing the ranking.

To apply a ranking, click on the data in the column containing the measure you wish to rank and clink

on the Ranking button.
Er D

. . Hevenue
utme Object £ Lot o Source

Name Source .,

Select the largest n
values,

To... Do This...

Click Top and select the value
of n. (BusinessObjects selects
3 by default when you click
Top.)

Select the smallest n
values,

Click Bottom and select the
value of n. (BusinessObjects
selects 3 by default when you
click Bottom.)

Select the top n% of
values,

Click Top, click In percentage
of total number of values, then
select the value of n.

Select the bottom n% of
values,

Click Bottom, click In
percentage of total number of
values, then select the value
of n.

Display Subtotals relating
to the values that appear
in the report and the
values that are omitted
from the report,

Click Display subtotals.

Display percentages
relating to the values that
appear in the report and
the values that are
omitted from the report,

Click Display percentages.

You can display the top or boktom values of the chosen
oy data,
a0
40 Selection
40
A0 B e :l Fund
5 [ Bottom :l
348 Based on: |F'|:usting Arnounk j
36
C[5) [ In percentage of tatal number of values
C[5)
36 Calculations
35 [ Display subkatals
3B [ Display percentages
QK | Cancel Help
Alerters

Select the measure on
which the ranking is
based,

Choose the measure in the
Based On combo box.

You may highlight data in a Desktop Intelligence report using Alerters. Alerters use special formatting to
make data that fits certain conditions stand out from the rest of the data. This helps draw attention to

trends and exceptions in report data.

1) Open Chapter3_Creating a Report—YourName.
2) Save the report as Chapter4_Alerters—YourName.

There are 4 steps involved in creating an Alerter:
a) Select the data you want to use.
b) Name and describe the Alerter.
c) Define the range of values.
d)

Define how the Alerter will be displayed in the cell.

Once you have created an Alerter you may apply, hide, display, edit or delete it.
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Step 1: Select the Data

a) Inthe report, click a cell, row or column of data.
b) Click Alerters on the Format menu or click the icon

on the Reporttoolbar.

c) Inthe Alerters dialog box that appears, click Add. Add.. % | |

Step 2: Name and describe the Alerter

b) In the Name box in the Definition 'Edit Alerters
tab, type a name for the Alerter.

c) In the Description box, type a
help text on the alerter to remind
you and others what the Alerter is
set to highlight.

d) Click the Conditions tab.

Description:

Definikion lCl:unl:Iiti-:nns ]

ﬁ In this by, wau define a new alerter or edit an existing one,

De=scription:

This alerker will find amounks greater than $50,000,

Step 3: Set the Conditions

a) Choose a variable from the Variable to EiLEIEE
Compare listbox. Defintion Condtins |
b) Choose an Operator from the Operator 1 e 1o canpae
IIStbOX' |PostingAmount ﬂ Add...
o Type a value (number, character or
date), or Operator 1 Walue 1 Operator 2 Result
o Click the down arrow button to the b= =l [s00000  v|[ane -] Cell Content

right of the Value 1 listbox, then click None
Variables or List of Values. Select a

variable or a value.

c) If Operator 1 requires the use of a second

operator, click the Operator to use in the

Operator 2 box.

d) Click inside the Value 2 box and repeat

Step 2.

Posting Amount

585,354.81 .
s13.s0] Step 4: Set the Formatting
20,912.49 a
5,344.52
43,163.37
51,012.69
96,170.78
377 .58
S00.00
26.69
228.810.07
55.836.41 dialog box.
72,810.14
431.503.91

Q>0 O O T

B

Ok Cancel Apply Help

) Click the arrow next to the Cell Content box and a shortcut menu will appear.
) To have the Alerter display text, click Text.
) Type the text, then click OK.
) To have the Alerter display a variable or a formula, click Variables.
) To format the cell contents, click Format.
In the Cell Format box, format the text, then click OK.
) Click OK, to apply the Alerter and return to the Edit Alerters
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Chapter 5: Formulas and Variables

Sometimes the simple calculations offered do not meet your analysis needs. In this case, you may
need to create custom calculations such as formulas or variables. Formulas and variables are very

important because they are used in almost every cell in a report.

What is a formula? Formulas are sentences that can be evaluated. Some are very simple and others
are very complex. However, all are logical and follow certain rules. All formulas begin with an equal
sign (=). The equal sign tells Desktop Intelligence to evaluate the formula instead of just displaying the
text. Variables are simply named formulas. Formulas may be complex so we often give them a name
and then refer to the formula by name instead of working with the entire formula.

Viewing Formulas in a Report

To view a formula in a report, double-click on the cell that contains the formula. This will place the cell

in edit mode and reveal the formula.

Fund Name Expenditures

Finance Facilities Service: ol

132 Finance Federal Surplus |
132K Finance State Surplus Fu
1400 Fin-Frm Hist Properties Fu
3700 Property Mhanagement Fu

Revenue

-75 B4E.VE

1,392 410.85

-1,300 555,20

-30,742.48

-43 2705597 745

Double clicking on cells to reveal formulas works well for short formulas, but it is difficult to view longer
formulas because the cells are often much too narrow to display the entire formula. In the example
above, the field was enlarged so that the formula could be displayed. It is easier to view the formula in

the Formula Bar.

v’ff* ﬁ\ |=Sum[<E:-:|:uenl:|itures>]
I

hg

Fund Name Expenditures
Finance Facilities Service: =

132J Finance Federal Surplus |
132K Finance State Surplus Ful
140 Fin-Fm Hist Properties Fu
3700 Froperty Management Fu

Revenue
75 Rd6 TR
-1.392 410.85
1,300 53520
-30,742 48
-43 270,597 75
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Creating and Editing Formulas and Variables

You may edit a formula by double-clicking on the cell and then modifying the formula directly in the cell.
After modifying the formula, press the Enter key to save the changes. Modifying formulas in cells may
be cumbersome. Another method would be to edit the formula in the Formula Bar. After modifying the
formula, press the Enter key to save the changes. Both of these methods are a quick way to modify or
enter a formula; however, both ways require an understanding of formula syntax. Syntax is the
structure of a formula. For this reason, Desktop Intelligence has provided a Formula Editor that checks
the syntax of formulas. Using the Formula Editor, if the formula is syntactically correct, Desktop
Intelligence will allow the formula to be created. If it is incorrect, Desktop Intelligence will not accept the
formula and may or may not give a reason for the improper syntax.

Formulas may be typed directly into the edit field provided or they may be created by double-clicking
formula components in the sections below the edit field.

Formula/Variable Editor

Formulas
This is an edit field that allows you
to create or modify formulas.

Variable Editor

Diefinition  Formula }

Va_riables . . . Formulas
This section lists all Universe =If { «Closing Classification=z="10" Or <Closing Classification=="11") Then "¥es" Elze
Objects that are available in the "Mo"
report. It contains all objects from
the Query Panel and all variables Yariables Functions Cperators
that are created within the report- Accounting Period All Functions & agagre # &
It does not contain any formulas Closing Classification Angregates +
that are in the report. If you want Department Mummeric Functions
to use an existing formula, you will Expenditures Flag Character functions
need to make the formula a Fiscal Year Date Functions
variable. Fund Logical Functions

Revenue Flag Document Functions
F . Expenditures Daka provider Functi

U.nCt.IOI‘lS \ Pasting Amounk i Misc Functions b/
This lists all of the functions that ¢ ¢
are available in Desktop
Intelligence. A few will be covered
later in this chapter.
(0] 4 | Cancel | Help

Operators
This section lists all of the

operators that can be used
within the formula depending
where the cursor is in the
formula.
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Scenario: After showing the Expenditures and Revenues to Date report to your boss, he indicated that
he preferred to see the report broken down into totals for Expenditures and Revenues instead of all
amounts in one column. We are going to create two variables, Expenditures and Revenue, and add
them to the table.

1) Open the report titled Chapter3_Creating a Report—YourName.

2) Go ahead and Save the report as Chapter5_Formulas-Variables—YourName. This way, if you
need to start over, you will still have a clean copy of the first report we created.

3) For now, remove Closing Classification and Posting Amount from the table.
Before creating the variables in our report, let’s cover a few topics related to variables.

Creating Variables

There are several ways to create a variable. One method is to create a variable from an existing
formula in a table. This method works well since it allows you to see how the formula will work in the
report before it is made into a variable. To create a variable from a formula, click on the cell that
contains the formula and select from the menu bar Data > Define as a Variable. This will open up the
Define the variable window which will allow you to name the variable.

Define the variable E|
. . Marne: |FLIND
Data  Analysis  Window He
Variables... =<Fund Mame>

£N Edit Formula..,

b Define as Variable. .. oK | Cancel ‘ = |

Another method for creating variables is through the @ ; i b b add. et and "
. . ou Use Chis Do [0 3dd, edit and remove varlables,
Variables Dialog Box. W as well as o insert variables in the report.
e (lick on Data and then click on Variables. 2 % In Alphabetical Order (B¢ By Data Pravider
The Variables dialog box allows you to Accounting Period -
manage variables in a report. It allows Clasing Classfication
you to add, delete, and/or edit local et
variables.

Posting Armount
¥ Department Marme
e (lick the Add button in the Variables dialog box. ¥ Fund Name
Farmulas
Constants

' Data | ] Map -
% Data | [] Map | ‘ Another way to add a new i .
roup. ..

—l-{== Wariables
| Accounting Period

variable is to right click in
the Report Manager and | Description:
select New Variable. The identification code associated with a fund recard.

ECETT.

@ Edit Data Provider. .. Replace Close Help

Blew Dats Provider, .,
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The Variable Editor dialog box will be displayed. The Variable Editor contains two tabs used to create a
variable—the Definition tab and the Formula tab.

The Definition tab allows you to Name [/ Eaary. X
and Qualify the variable. To name the
variable, type a name into the Name Definition | Formula |

field. To qualify the variable, select any Name Tops
one of the Qualifications. However, any |
variable that contains a mathematical
function in its formula must be a Qualfication

Measure Object. This object has the Following ification For multidimensional analysis:
e On the Definition tab, name the * Dimensian T Ty0e ‘Expenditures Flag’
first variable as Expenditures { Measure \ in the name field.
Flag. This variable’s b Detal
qualification is going to be Select "Dimension” as the
Dimension. Qualification.

| Cancel Help

Using Operators/Functions in Formulas

Every formula has at least one operator, which is the equal operator. Operators allow us to create
formulas using the available objects and functions in Desktop Intelligence. Let’s look at some of the
operators.

Mathematical Operators

The standard mathematical operators are available in Desktop Intelligence (+,-,/,*). They are used in
the normal ways, with standard mathematical precedence.

If-Then-Else Operators

The If-Then-Else operators allow us to create output based on variables within the report. The general
syntax is

= If (Something is True) Then (Do This) Else (Do Something Else)
Using this syntax, we will be creating variables for our report.

There are also instances where we do not care about an Else clause in our formulas. If the Else clause
is excluded from the formula, the formula will return nothing (blank) if the logical part returns false.

You may also nest /f-Then-Else operators within other If-Then-Else operators.

= If (Something is True) Then (Do This) Else (If (Something Else is True) Then (Do That) Else
(Do Something Else))
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Other operators are InList and IsNull. The InList operator may be used to determine if something is
equal to one of the values specified. The IsNull function determines whether a constant or variable is
null (empty).

Aggregate Functions

Aggregate Functions operate on a set of values. For example; Sum, Average, Maximum, Minimum and
Standard Deviation are all Aggregate Functions.

Sum
Syntax: Sum(number)
Description:  Returns the sum of numeric values
Example: Revenue
14,409
22,221
33.706
Sum 70,336
Average
Syntax: Average(number, number,...)
Description:  Returns the average of a set of numeric values
Example: Revenue
14,409
22,221
33,706

Average 23,445

Using Min or Max to Remove the #MultiValue Error

#MultiValue errors occur when trying to fit too many values in a context. The most common reason for
this error is trying to display a Dimension or Detail in a freestanding cell. Desktop Intelligence will
always give the #MultiValue error when this is attempted because there is no way for the multiple
values that a Dimension or Detail may represent to be displayed in a single cell. You may use the Min
or Max function to allow you to place a Dimension or Detail in a freestanding cell.

There are many other Operators and Functions, too many to go over in training, that are available in
Desktop Intelligence to meet your reporting needs. Desktop Intelligence provides help on all Operators
and Functions.

The “Flag” Rule

In creating our variables, we will follow what is referred to as the “flag” rule: Create a flag for any
conditions (as a Dimension), then use the Where clause in the definition of your Measure. This
approach is recommended because it simplifies reports and is compatible with Webi functionality.
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Following the “flag” rule, the variables in our report should contain the following formulas:

Expenditures Flag
“Yes” Else “No”

Expenditures

Revenue Flag
“Yes” Else “No”

Revenue

On the Formula tab, we are going to define our first formula.

=<Posting Amount> Where (<Expenditures Flag>= “Yes”)

=<Posting Amount> Where (<Revenue Flag>= “Yes”)

=If (<Closing Classification>="10" or <Closing Classification>="11") Then

=If (<Closing Classification>="14" or <Closing Classification>="15") Then

=If (<Closing Classification>="10" or <Closing Classification>="11") Then “Yes” Else “No”

1. Click on OK, the variable will
show up in the Variables Class in
the Variables dialog box.

Variable Editor

Definition  Formula ]

%,

=If { = Closing Classification=="10" Or <Closing
Classification=="11"1 Then "ves" Else "Mo"

Close | Help

Farmulas
Variables Tﬁ};:{::closing Classification>="10" Or <Closing Classification>="11") Then "Yes" Else
]

¥ou use this box ko add, edit andfemove variables,

as well as to insert variables in ghe report Variables Functions Operators
* (¢ In Alphabetical Order @ " pf Daka Provider Accounting Period 8 B All functions & aggre @8 i

- Closing Classification Aggregates
= variables _ _ ~ Diepartmeant Murneric functions

ncc?untlng Pfe_rlod_ Expenditures Flag Character functions

Elosmf Claiﬂﬁcatln Ficcal Year Diate Functions

. pr e - Fund Logical functions

""F":"'u' &5 ad Revenue Flag Document Funckions

iscal Year
Expenditures Data provider Functi
Fund . (v ; - v
. Pasting Amount Misc Functions
Pasting &mount < £
¥ Department MName
¥ Fund MName
[+ Frrrmnilas b
add... Group. .. Edit... Remove |] oK | pa— | Help
Descripkion:

N

You may also use the Variables dialog box to edit or

remove existing variables.

2. Click on Add again and add the Expenditures, Revenue Flag, and Revenue variables.

3. Drag both the Expenditures and Revenue variables that you created onto your report after

Fund Name.

Fiscal Year Accoun Depal Department Nam Fund Fund Name Expenditures Revenue
2007.00 1.00(785 [Facilities & Supp|132H  |Finance Facilities Se -4 410,00
2,007.00 1.00(785 |Facilities & Supp|132)  |Finance Federal Surg 37 ,275.09 -478 95440
2007.00 1.00(785 [Facilities & Supp|132K  |Finance State Surplu 17 937 .55 -428 088.97
2,007.00 1.00(785 |Facilities & Supp[14D%  |Fin-Fm Hist Propertie -1,025.00
2,007.00 1.00(785 |Facilities & Supp|3700  |Property Managemer 1,341 53516 -510.00
2.007.00 200785 |Facilities & Supp[132H  |Finance Facilities Se 509.25 -1.786.50
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4. Save the report.

Editing Existing Variables

To edit a variable, select it in the Variables dialog box and click on the Edit button. This will open the
Variable Editor. Any of the variable’s parameters, including the name, may be changed. If the name is
changed, the change will disseminate throughout the report. You may also edit a variable by right-
clicking on a variable in the Report Manager and selecting Edit Variable from the pop-up menu.

Remove Existing Variables

Desktop Intelligence does not automatically remove
unused or unwanted variables and formulas from a
report. If a variable or formula is no longer valid, the
Variable dialog will identify this by placing an exclamation
mark preceding the formula or variable name. A formula
may become invalid for many reasons, but the most
common reason is that one of the variables that the
formula or variable depends on has been removed from
the Query Panel.

To delete these unwanted formulas or variables, select
the object in the Variables dialog box and then click the
Remove button.

Variahles
L]

L

4 (+ In Alphabetical Order

3

‘fou use this box to add, edit and remove wariables,
as well as to insert variables in the report,

@ " By Data Provider

Bl

=]

Yariables -
Accounting Period
Departrment
Fiscal Year
Fund
/% Expenditures
Pasting Amounk
£3 Revenue
¥ Deparkment Mane
¥ Fund Mame

Frrrnnilas

add. ..

Descripkion:

Close Help
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Exercise 2: Using Formulas and Variables

Review
1) Name four Simple Calculations:

a)
b

o O

)
)
)

2) What is the difference between Count and Count Alf?

3) Ranking enables you to

4) Name the four steps involved in creating an Alerter.

)

O T o

)
)
)

o

5) A Variable is simply

6) What are the benefits of using Variables instead of inserting a Formula into a cell?

7) What are the three steps to building a Variable?
a)
b)
c)
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Hands on Instructions

Task Overview

Use the report created in Exercises 1 (Exercise1_ExpRevRpt—Your Name) to practice using

variables in a report.

For this exercise, you will modify the query and report built in Exercise 1 by adding 3 variables to the

report.

This report will use prompts but we will retrieve data for Fiscal Year 2008 and Accounting Period 6 only.

Procedures
1) Open and log in to Desktop Intelligence.

2) Open Exercise1_ExpRevRpt—Your Name.

3) Save your report as Exercise2_FormulasVariables—Your Name.

4) Edit the query to include Closing Classification.

5) Remove Closing Classification and Posting Amount from the table.

6) Create 6 variables and add the non-flag variables to your table:

Accrued Expenditures Flag =If <Closing Classification>="11" Then “Yes” Else “No”

Accrued Expenditures
Cash Expenditures Flag

Cash Expenditures

Revenue Flag

Revenue

Accou

Fiscal Year nting

Period

Depa
men

Depart
ment
Name

=<Posting Amount> Where (<Accrued Expenditures Flag>=“Yes”)

=If <Closing Classification>="10" Then “Yes” Else “No”

=<Posting Amount> Where (<Cash Expenditures Flag>="“Yes”)

=If (<Closing Classification>="14" or <Closing Classification>="15")
Then “Yes” Else “No”

=<Posting Amount> Where (<Revenue Flag>=“Yes”)

Fund Eund Object Object Name
ET

Reven Rewenue

Source

Source Name

Cash
Expenditures

Accrued

Expenditures RENSnLS

20050001 B.00|785 Facilitie|132H  |Finance|E161 Prison Labor (Fymts To Cort] 20288
2008.00 B.00|785 Facilitie| 132H Finance F402 General Re| -229.00
2008000 600|785 Facilitie|132H  |Finance R404  |General Feg -735.00
2 108.00 5.00(785 Facilitie| 132 Finance|E111 Regular Salaries And Wages 16,045.95
2108.00 G.00(785 Facilitie| 1324 Finance|E121 Employers Fica 1,154.07
2008.00| 600|785 Facilitie|132J Finance|E122  |Emp Ret-Inc Paymt F/Sick L 1,363.92
2005000 6.00|785 Facilitie| 132 Finance|E123 Employers Health Insurance 242408
2008.00| 6.00|785 Facilitie|132J Finance|E124  |Ermployers Life Insurance 11.16
2008.00| 600|785 Facilitie|132J Finance|E161 Prizon Labor (Pymts To Caorr) 878.72
2005000 B.O0|785 Facilitie| 1324 Finance|E191 Ternporary Manpower Serdic 740052
2008.00 B.00|785 Facilitie| 132J Finance|E211 Matural Gas 14,58

7) Save your report.

8) Close your report.
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Chapter 6: Simple Formatting

Before moving on to more complex formatting such as Breaks and Sections, it is important to review
simple report formatting such as formatting text, numbers, cells, tables, page layout, etc.

You have complete control over the look of your report. You may move table columns, move
freestanding cells, change fonts, colors and other formatting to customize your report. We will start by
looking at the formatting options for individual cells.

Cell Formatting
1) Create a new report from the General Accounting Universe.
2) Use Department, Department Name, Fund, Fund Name and Posting Amount (Basic Ledger)

3) Set conditions for Closing Classification = 11, Fiscal Year = 2008 and Accounting Period =
6.

Result Objects

Departrnent | » Department Mame

Fund P Fund Mame
Posting Amounk

Conditions

Closing Classification Equal ta 'l 1'|

And
Fiscal Year Equal ko 2008|

And
Accounting Period Equal to 6|

4) Run the Query.
Your report should look similar to this.

Department DepartmentName Fund Fund Name Posting Amouni
785 Facilities & Support 0100 General Fund 11 224 51
785 Facilities & Support }132] Finance Federal Su 25202
785 Facilities & Support (132K Finance State Surp 1,338
785 Facilities & Support | 140% Fin-Fm Hist Proper 0.0a
785 Facilities & Support 3700 Froperty Managem 344010

5) Double-Click the right border of the Department Name column to resize it.
6) Double-Click the right border of the Fund Name column to resize it.

Department Department Name Fund Fund Name Posting Amount
=] Facilities & Support Services {0100 General Fund 11224681
=] Facilities & Suppart Services |1324 Finance Federal Surplus Fund 25202
795 Facilities & Support Services [132K Finance State Surplus Fund 133921

Double-clicking will resize the cell to the largest text in the cell. The other way to resize the cell is to
drag the cell border to the size you wish it to be.
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Changing Column Headings

When a report is created, Desktop Intelligence uses the names of the objects as the default column
headings. These headings may easily be changed to something more appropriate.

7) Double Click the Posting Amount column Header Cell.
The formula for the cell is displayed, =NameOf(<Posting Amount>). Smount=

1122461
25202

8) Type the new heading, Expenditure, and press the Enter key.

NOTE: Only the column heading has changed. The object name for the column remains Posting
Amount.

Text Wrapping

If the text within a column exceeds the column’s width, and you don’t want to widen the column to fit the
content on one line, you may have the text wrap to multiple lines within the cell. This is especially
useful when the name of an object is much longer than the values for the object. For example, if an
object has possible values of Y or N, the name of the object will be much wider than the values.

We will wrap the text in the column heading. You may wrap the text in the body of the table in the
same way.

9) Move the cursor over the left edge of the header row. The mouse cursor will change to a black
arrow pointing to the right.

10) Click to select the header row.

:Eftlepartment Department Name Fund Fund Name Expenditure
k3
11) Right-Click any where on the header row to display the pop-up
menu. : _
LICTr | Nurnber A“Qnment]Font lBordel] Shadmg]
o K CL M b o) Select Format Cell... Hofeondl
— Hﬁ Copy Chrl+C 1 " General
S [@easte cwbv | 13) Select the Alignment tab. © Lot T
_S ] (" Center
Els Pl 7] 14) Select Wrap Text in the Settings portion of | | - ..
5 X Delete the dialog box. This will cause the text in the r Ly
Em_ cell to wrap to a new line. o
L ] ethings
= ™ Fil [
15) Select Row by Row Auto Fit. This will cause the height of each B =t
row to increase only if the text for that row has multiple lines. J 3o g s ts
~
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Wertical

C Top 17) Click OKto
" Center

* Battarn

close the dialog box.

16) Change the Vertical setting to Bottom.

If you resize the cells on the table, you will notice that the header cells wrap.

Department Ll Fund ] Expenditure
Name Name

785 Facilities & Suppd0100  (General F 568 B31.57

785 Facilities & Suppi{132H  |Finance F 20288

785 Facilities & Suppd132d  |Finance F 40,793.74

785 Facilities & Suppe[132K. |Finance 3 2184774

Custom Border

In the Format Cell dialog box, you have the option to change the border on any cell.

18) Move the cursor over the left edge of the header row. The mouse cursor will change to a black

arrow pointing to the right.

19) Click to select the header row.

20) Right Click and choose Format Cell.

On the Border tab, you have four
areas available to you to apply
border to cells in the table.
Presets allow you to quickly
remove or add border around
cells. You may manually add
different types of border to a cell
by first clicking on the Style you
wish to use and then clicking in
the Border section where you
wish the border style to be
applied. You may also choose
the Color of the border to be
used.

21) Change the border on
the header to double
lines on the bottom of
the cell.

Cell Format

MHumber I Alignment I Font

Border ] Shading |

Presets Style
Mohe Box |
Border | ........................................................

_____ o | —

Cuolor

— f+ Atomatic
B Gt I
Ok I Cancel Apply Help
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Custom Font/Shading

The font of a cell may be changed and the cell may be shaded according to your preferences. The
Font tab in Format Cell allows you to choose the Font, Font Style, Size and Color. You may also add
Effects such as Underline and Strikethrough. As you make changes to the font, the Preview window
allows you to view your changes before Applying them to your report.

Cell Format E|
Numher] Alignment  Faont l Bu:uru:ler] Shadingl
Font: Fant Style: Size:
Aial |Eold 10
i i 3
B Aial Balic T )
T Avial Black Bold Italic 14 hd
T Anial CE
T Auial CrR Coalor
Tp Anial Greek, .
i
T Arial Marow HILTE 2
T Asial Rounded MT Bald (* Custom
T fial TIHR b
Effects Prewvigw
[ Underline ‘
[ Shikethrough
oK | Cancel | Apply ‘ Help

Shading may be applied on the
Shading tab. You may choose
None under Fill if you do not
wish to apply shading to a cell.
Custom allows you to customize
the color and intensity of the cell
shading.

You may also pick your color
preference for the Background
and/or Foreground Color. Under
the Shading section, you may
choose how dark the shading
should be in the cell.

The Preview window allows you
to visualize the effects prior to
applying them to your report.

Numl:uer] .-’-'-.Iignment] Fant ] Border Shading l

Fill Foreground Color:
" Mone f* Cusztom (™ Automatic
Sy  cuso [
|5IZI?<.’
B Goid(100%) = Background Color:
" Autornatic
0+ Cusztam:
2R
12% Preview
i B
e 3
= [ark Horizontdl
I Dark Vertical
B Dark Diagonal [low]
%2 Dak Diagonal [High) v
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23) Change the font color to black.

22) Change the font style to Times New Roman.

23) Make the Font Style Bold and the Size 12.

24) Change the Shading to a light grey at 50%.

25) Highlight the data rows in the table and remove the border.

Department ﬁepartment Fund Sne Expenditure
ame Name

785 Facilities & Suppc 0100 General F 5B8 B31.57

785 Facilities & Suppt 132H Finance F 202.88

785 Facilities & Suppc 1320 Finance F 4079374

785 Facilities & Suppc 132K Finance 3 2184774

Number Formatting

Number formats may be displayed in many different ways by choosing different formats. There may be
different format settings for positive and negative values as well as for zero and null (empty/blank)

values.

26) Right Click a value in the Expenditure column to select the column and display the pop-up

menu.

27) Select Format Cell... from the pop-up menu.

28) Click the Number tab if it isn’t already displayed and Click on Number under Category.

Category allows you to choose the
type of formatting you want for the
number.

Format allows you to choose how
you want the Category formatted.

Properties shows you how the
Format you selected will be
displayed and allows you to make
changes to that formatting.

29) Under Format, choose 0.00.
30) Under Properties, define

how Negative, Equal to Zero,
and Undefined should be

Mumber }ﬁ.lignment] Font | Border | Shading |

Cell Format

Categomy Format
Standard #4000 FS
Al 1]
Custarn o0 ... |
M urnber # HH0
Currency # AH0.00: 4, ##0.00):0.00:0.00
Date/Time HEHHHH H0.00;(HEH tHE H10.00):0.00,0.00
Scientific # #4#0.00; 4. #40.00); ;0.00
Percentage # AH0 008 #4#0.00); ;
Condition 0.
Boolean Rt i H0 00 (08 $HH $H0.00):0.00:7
image 00000 v
Properties
Pozitive Negative Equal to Zerno Undefined
.00 -0.00 FEM Ermpty
12345.68 1234568 Zemn Empty

shown.
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If the number formatting is set as shown on the previous page, this is what the report would look like.

Departinent Fund Expenditure
Departinent  Name Fund Name S
785 Facilities & Supg 0100 General Fu 11224 61
785 Facilities & Supp 132J Finance Fe 252 02
785 Facilities & Supp 132K Finance St 133921
785 Facilities & Supp 1404 Fin-Fm His faro
785 Facilities & Supp 3700 Froperty M 344010
785 Facilities & Supp COBEB Relacate L fero
785 Facilities & Supp C210 Capitol He fera
785 Facilities & Supp C23T Fire Alarm fero
785 Facilities & Supp C24M Client Acce fera

Alignment of Cells/Tables

Desktop Intelligence offers several options for alignment within a report.

Aligning Cells with the Grid

One way to align the edges of several elements on a page is to use the Grid option. You may access
Grid settings by clicking on Tools > Options on the menu bar and then selecting the Display tab.

The Show Grid option displays a
grid of lines on the background
and allows you to determine the
distance between the grid lines.

The Snap to Grid option forces
the upper-left corner of any
element you move to a grid line.

Height and Width allows you to
set the size of the grid.

Depart]
785

=

General] Save Display ]Drill ] File Lu:uc:atiu:uns] Mew Du:u:ument] Macru:us]

G Here, you et optional features that pou want to dizplay by default.
There are settings for the application window, and for reparts.

Application Options Fepart Options

[v Status Bar v Alerters

[v Formula Bar [ Dutline

Measurement Units: [ Cell Delimiters

|1"'I-I Bth Inch j v Section Delimiters
[ Show Grid

WWindow Options [~ Shap to Grid

[+ Horizontal Scroll Bar

Height; j 1/16th Inch

- .
v ertical Scroll Bar \idth: :II 116tk Inch

[v Report Tabs
[ Show Calars in Slice-and-Dice Maode

Ok | Cancel Help
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31) Click on Tools > Options.
32) Select the Display tab.
33) Check the Show Grid and Snap to Grid options.

34) Change both the Height and the Width options to 2 to make the lines of the grid 1/16™ of an
inch apart.

35) Click OK.

General] Save Disgplay ] Doill I File: Locatinns] Mew Dncument] Macrns]

dhal® Here, you zet optiohal features that you want to dizplay by default.
There are zettings for the application window, and for reports,

Application Options Report Options

[v Status Bar v Alerters

v Formula Bar [ Outline

teasurement Units: [ Cell Delimiters

|1”1 Bth Inch j v Section Delimiters
I Show Girid

window Options ¥ Shap to Grid

= )
[v Harizantal Scroll Bar Height lz—ﬁ_lﬂ St Inch

v I =
v “ertical Scroll Bar \wickhe lz—j 1AEth Inch

[v Feport Tabs
™ Show Colars in Slice-and-Dice Mode

QK | Cancel | Help |

36) Move the table and the Report Title around on the page so you can see how the table and the
cell snap into place on the grid.

Aligning Cells Using Align Elements

The Alignment option also allows you to align the edges of cells. Align Elements is found under Format
> Placement > Alignment on the menu bar.

This option moves the second cell selected in alignment RlU:INAELELIE X
with the first cell selected so that the specified edges align. o
The order of selecting the cells is very important. The first iy
cell selected becomes the anchor. The second cell = @ Let
selected will be moved to match the location of the first. ow ( Center Cancel
a0 S| © Right Apply
37) Insert two blank cells on to the report. = T Tap
Help
38) In the first cell, type FIRST, and in the second cell, LSS
type SECOND. me
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39) Move the cells around so that they are not aligned.
40) Hold down the CTRL key and click on the FIRST cell.
41) While still holding down the CTRL key, click on the SECOND cell.
42) Click on the menu bar on Format > Placement >Alignment.
43) Choose an Alignment (for example, Left) and click OK.
The SECOND cell should have aligned with the FIRST cell.

Aligning Cells/Tables Using Relative Position

Relative Positioning allows you to specify the location of a cell or a table/block relative to another cell or
table/block. For example, a text cell may be positioned one half inch below the bottom of a table. If the
table changes size after a refresh, the text cell will still be one half inch below the table if Relative
Positioning is used. This ensures the elements don’t overlap.

Cell Format E]
MHurmber ] Alignment ] Faont ] Baorder ] Shading Appearance l
“ou can name the selected cell, You can change the size and position and zet a
conditian to determine whether the cell iz hidden or dizplayed.
Mame Cel
Pozition
Sample
Horizontal Pozition Relative to; Left
|U|:u|:uer Section ﬂ |28 j 1/16th Inch
Yertical Position Relative to: Top
|U|:||:|er Section j |2 j‘ 1/16th Inch
Size
Width B7 = 1/16th Inch Height 7 = 1/16th Inch
[ Hide Cell
| Edit..

k. | Cancel | | Help |

Note: The reference point for a block for the relative positioning is the lower-right corner of the block.
For example, if the position is relative to a table and the settings for Left and Top are both 0, the
location is the lower-right corner of the table.

44) Insert another table onto the report (Insert > Table)

45) Use existing data from the document and select only Department and Fund.
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46) Right-Click on the new table and select Format Table.
47) Click on the Appearance tab.

48) Set the Horizontal and Vertical Position Relative to: Table 1.

Pozition
Harizontal Pozition Felative to; Left Sample
Table 1 | [0 =18t Inch
Yertical Position Felative to; Top ‘m
| Table 1 ~| [0 {18t Inch

Notice when you click OK that the new table is aligned to the lower-right corner of the original table. By
changing the numbers for Left and Top, the table will be locked in position relative to the position of the
element it is set relative to. When that element changes shape or size, the position of the new table will
also change.
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Exercise 3: Applying Simple Formatting

Review
1) True or False Double-clicking on a cell will resize the cell to the smallest text in the cell.
2) True or False If text exceeds a column width, there is no way to fit the content on one

line without widening the cell.

3) Row by Row Auto Fit will

4) What are the four areas available to you on the border tab?
a)
b

o O

)
)
)

5) Onthe Numbertab, Category allows , Format allows

, and Properties allows

6) One way to align the edges of several elements on a page is to use the option.

7) Name two other options, other than the option in Question Six, that helps with alignment.
a)
b)

8) Relative Position allows you to
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Hands on Instructions

Task Overview

In this exercise you will take some time to practice the formatting techniques learned in this chapter.

Procedures
1) Open and log in to Desktop Intelligence.
2) Open Exercise1_ExpRevRpt—Your Name.
3) Save your report as Exercise3_SimpleFormatting—Your Name.
4) Use the techniques shown in this chapter to practice formatting your report from Exercise 1.
5) For example, practice the following:

a) Cell Formatting
i) Resize columns
ii) Change column headings
iii) Wrap text

iv) Change font
V) Change shading
Vi) Change borders
vii) Change number formatting
b) Cell/Table Alignment
i) Align cells using the grid
ii) Align cells using Align Elements
iii) Align tables using Relative Position
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Chapter 7: Crosstab Reports

Crosstabs are a process or function that combines and/or summarizes data from one or more sources
into a concise format for analysis or reporting. A crosstab is the cross referencing or comparison of
two variables (such as amount spent per Object Code per Fiscal Year) to determine how they are
interrelated. A crosstab gets its name from the layout of variable definitions into rows and columns.

Let us walk through building a cross tab report in Desktop Intelligence.

1) Inthe New Report Wizard, Create a New Report screen, click on Generate a Standard Report.

New Report Wizard

Create a New Report

This wizard helps vou create a new repart. It enables vou to
specify the report layout and the data you want to display.

-’ 4 For the report layout, you can:

{* izenerate a standard report

i Select a kemplate

Click Begin ko specify haw ko access data

Beqgin = | Cancel

2) On the Specify Data Access screen, choose Universe and click Next.

New Report Wizard

Specify Data Access

‘with Deskbop Inteligence, vou can work with corporate
data, as well as with personal data, There are different

-’ ways ko access the data you wank o wark with,

# Select the way you want to access data:
{* Universe

Use a Desktop Intelligence universe to choose the
data to display in a repart,

" Others
Persanal data Files j

Use an Excel, dBase or ASCII file b retrieve data
and display it in a report

< Back | Mext = | Cancel
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3) When the Select a Universe screen comes up, select the General Accounting Universe to build

the report from and click on Finish.

New Report Wizard

Select a Universe

Tao access universe data, select a universe,

# Available Universes:

Diocument Catalog ~
Docurent Phase Universe--KY
eFashion

ePay
Fixed Assets

Ij!
Geographic Location hd
L >
I Set as My Default Universe
Help on the selected universe:

< Back | Finish | Caneel

4) Drag the following into the Result Objects Panel:

Accounting Period > Fiscal Year

COA-Fund Accounting > Object >Object

COA-Fund Accounting > Object >Object > Object Name
Basic Accounting Ledger > Posting Amount

Resulk Objects

Fiscal ear Chject
b Object Mamne Posking .ﬁ.mu:-unt| |

5) The crosstab will show the amount expended for certain Personnel costs by Object for each Fiscal

Year. The following Conditions should be set up to obtain this information:

Object In list ‘E111,E121,E122, E123,E124"  Cendtions

AND. ey . ‘ , Object In lisk 'E111,E121,E122,E123,E124'|
Closing  Classification In list ‘10,11 and
(Cash and Accrued Expenditures) Closing Classification In list '1|:|,11'|

AND 1L [ .
Fiscal Year In list 2007,2008 ez o= AT

6) Runthe query.

62 of 227



eMARS Desktop Intelligence Reporting

Upon running the query, the initial results will be laid out as depicted below. However, Posting Amount
results will vary based on when the report is generated.

Fiscal Year Object Object Name Posting Amount

2007 (E111  |Regular Salaries And Wages 11 528 30027
20071E121  |Employers Fica o458 ,809.30
2007 (E122  [Emp Ret-lnc Paymt F/Sick Leave 910 635.44
2007 |E123  |Employers Health Insurance 1,610 604.05
2007 (E124  |Employers Life Insurance b ,036.56
2008(E111 Regular Salaries And Wages 10,019 153.85
2003 (E121  (Employers Fica 728050028
2008|E122  |Emp Ret-Inc Paymt F/Sick Leave oo4 359 .43
2003(E123  [Employers Health Insurance 1,401 891 .22
2008|E124  |Employers Life Insurance 542190

The generated report gives us the information we were looking for, while a crosstab report will structure
the data so that a side-by-side analysis of expenditures in previous fiscal years and the current fiscal
year may be analyzed.

Insert Format Tooks Dat 7) |n order to create a crosstab report, delete the current table and click on
cf cell... Insert > Crosstab from the menu bar.

Special Field *| 8) When the icon to the right appears, click somewhere on the
blank report.

Chart Components  #

Sorks 4

:iu Table...

BT
U“f Chart...

. . New Crosstab Wizard
The New Crosstab Wizard will come  Foa s

up. Insert a New Crosstab

This wizard helps vou insert a new crosstab in the active report, You
must specify the data that you want to display in the new crosstab,

To display the new crosstab, you _,
can: # To display the new crosstab, you can:

(* Use existing data from the document

e Use existing data from the
document.

" Build a new query on the universe currently in use

(™ Access new data in a different way

e Build a new query on the
universe currently in use.

(™ Use an existing query ta build a new one

e Access new data in a different
way.

e Use an existing query to build a | |
new one.
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9) Select Use existing data from the document and then Begin.

The crosstab will be built using data retrieved by the query that has already been built. The other
options are similar to adding a new data provider. The same universe may be used to build a new
query, a different universe to build a new query, or the existing query may be copied to build a new

query.

10) After selecting Use existing data from the document and clicking on Begin, the screen below will
appear. On this screen, Variables to be used in the crosstab report must be selected. In this case,
all Dimension, Detail, and Measure Objects will be used. Select all Variables and click on Next.

New Crosstab Wizard

Insert a New Crosstab

Here is the list of wariables in the active document, You must
select the ones vou want to display in the crosstab,

& Select the Yariables

&+ In Alphabetical Order " By Daka Provider

[l variables

Formulas

Cancel |

< Back | Mext = |

New Crosstab Wizard

Pivot Data for the Crosstab

Here, you specify the variables you want to display in the
columns, raws and body of the crosstab, You can drag and
drop a variable from one folder ta another,

After the selection has been made; you must
specify how you want to display the information
in the crosstab.

# Crosstab Yariables:
=== Calumns
Fiscal Year
= Rows
Object
b Object Mame
Bady
Posting Amaount

B

I
—l

=
=8

< Back | Finish |

Cancel |

If we leave everything as it is set up in the screen shot above, this is how our data will appear.

2,007.00
2,008.00

E111

E121

E122

E123

E124

Regular Salarie: Employers Fica Emp Ret-Inc Pay Employers Heali Employers Life |

217 473967 37

115627 092,45

170,484 757 81

223,050 806.61

946,140.23

3,058,764.70

13,837 317 .57

21870504.32

19,384 898.24

74 613.83
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11) However, we may change the layout of the crosstab by rearranging the data to appear
differently on the Pivot Data for the Crosstab screen.

Mew Crosstab Wizard

Pivot Data for the Crosstab

Here, wou specify the variables wou want to display in the
colurns, rows and body of the crosstab, You can drag and

-] drop a wariable From one folder to anather,

& Crosstab Yariables:
FHE olumns

Ohiject
¥ Cbject Mame
E Rows
Fiscal Year
= Biody

Pasking &rounk

« Back, | Firish | Cancel |

By changing the layout of the crosstab, as shown in the above screen shot, the crosstab rearranges the
data as shown below:

NOTE: The Fiscal Year

Regular Salaries And Wages 217 473967.37|  3.06876470| | Was  formatted o
remove the decimals,

Employers Fica 115 527 092 45 13837 31787 which is the default

Emp Ret-Inc Paymt F/Sick Leave 170,434 757 81 21 870604 39 formatting for numbers.

Employers Health Insurance 223,050 80651 18,384 89524 Refer to the formatting

Employers Life Insurance 946 140 28 74 /1383 chapter for more
information.

At this point you have a functioning crosstab report that analyzes expenditures for various personnel
costs over multiple fiscal years. If you want to total the expenditures to get a grand total for each fiscal
year and a grand total for each object, you would simply insert a sum.

12) To insert a sum, click on the data under one of the fiscal year columns and then click on the

sigma symbol = (sum icon) on the toolbar.
4 hat | = - T El-lzEn g i B G D

o
Regular Salaries And Wages i 7 220,532,732.07
Employers Fica 115 A 129,464,410.06

Employers Health Insurance i 242.,435,704.85
14 1,020,754.16

785,808,963.34

Emp RetInc Paymt F/Sick Leave 0.4 04. 192,355,362.20

Employers Life Insurance

727,582,764.56 58,226,198.78

Sum:
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However, what if a total was not beneficial? How could one see the difference expended in each fiscal
year? If the total is removed, you can try to insert a column in order to add a variable that would show
you the difference. But if a column is inserted, the report ends up looking like the screen shot below.
An additional column is placed beside each value shown for fiscal year.

Regular Salaries And Wages pirvcr=ricrl I 3,058 ,764.70
Employers Fica 115,627 092.49 13,837 317.57
Emp Ret-Inc Paymt F/Sick Leave ERERERIERE] 21,870604.39
Employers Health Insurance 223,050 80651 15 3054 ,898.24
Employers Life Insurance 946 14025 74 /13.68

13) In order to show the difference between the fiscal years, a total must be inserted as shown in
Step 11 on the previous page.

Regular Salaries And Wages
Employers Fica

Emp RetInc Paymt F/Sick Leave
Employers Health Insurance

Employers Life Insurance

Next, three variables must be created. Two variables are needed to obtain the amounts for each fiscal
year. This is because of the way the crosstab is structured. If you look at the Structure View of the
crosstab, you will see that Posting Amount is broken out based on Fiscal Year but there is no definite
way to show that without a variable.

=<Fiscal Year> Sum:

=<0bj =<0bject Name> =<Puosting Amount>| =Sum{<Posting Amount=)

=Sum{=Posting Amount=)| =Sumi{=Posting Amount=)

Sum:

14) Create two variables: FY2007 and FY2008.
FY2007: =if <Fiscal Year>=2007 then <Posting Amount> else 0.00
FY2008: =if <Fiscal Year>=2008 then <Posting Amount> else 0.00
15) Now create a variable to calculate the difference between the two fiscal years.

Difference: =<FY2008>-<FY2007>
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16) Once all variables have been created, the formula in the Sum: column, =Sum(<Posting Amounts),

may be replaced with the variable Difference. Be sure t
variable Difference or you will receive an error.

In Structure View:

=<Fiscal Year>

=<0bj =<0bject N\ame> ==Puosting

o include the function Sum() around the

Difference

Armount= =Sum|=<Difference=)

Sum:

=Sum(<Posting Amount=)

=Sum(=Difference=)

In Report View:

27 473 867 37

Difference
(214,415,202 .67)

3058 764,70

Regular Salaries And Wages

E?f_ﬁplnyers Fica 115 627 092 49

13837 317.57 | (101,789,774.92)

21,870604.39) (148,614,153.42)

19384 B98.24 | (203,665,908.37)

74 B13.68 (B71,526.40)

Emp Ret-Inc Paymt F/Sick Leave 170,484 757 81
Employers Health Insurance 223050 50661
Employers Life Insurance 946 140,28

Total:| 727,582,764.56

58,226,198.78| (669,356,565.78)

There are many ways crosstab reports may be beneficial.
analysis of daily, monthly, quarterly or yearly activity.

The key is to practice using them for
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Exercise 4: Building a Crosstab Report

Review
1) Crosstabs are a or that
and/or data from one or more sources into a

2) A crosstab is the

3) Inthe New Crosstab Wizard, what are the four options for displaying a new crosstab?.
a)

b)

4) In order to show the Difference of two columns in a crosstab, what steps must be taken?
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Hands on Instructions

Task Overview

Create a new report created to practice using Crosstabs in a report.

For this exercise, you will create a report that will use a crosstab to compare Personnel Costs by Fund
Type and Fund for Department 785 for Fiscal Year 2007.

Procedures
1) Open and log into Desktop Intelligence.
2) When the New Report Wizard comes up, click Generate a Standard Report.
3) Click on “Begin >”.
4) Click Universe for Select the way you want to access data.
5) Click “Next >”.
6) Select General Accounting Universe.
7) Click on “Finish’.
8) Drag the following objects into the Result Objects Panel.

Fiscal Year

Result Objecks
Fund
Fiscal Year Fund
Fund Type
Object _# Fund Type| omea| |
Object Name F Object Mame Pasting .ﬁ.mn:nunt|

Posting Amount (Basic Accounting Journal)

9) Create the following Conditions:

Conditions
Fiscal Year Equal ko 2EIEI?|
and
Obiect In list 'E1111E1211E1221E1231E124'|
and
Closing Classification In sk ‘10,1 1'|
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10) Run the Query.

You should return results similar to these.

Fiscal Year Fund Type Fund Object Object Name Posting Amount

2007 (0100 0100 |E111  |Regular salaries And YWages 4 366, 782.00
2007|0100 0100 |E121  |Employers Fica IM25158.43
2007|0100 0100 |E122  |Emp Ret-lnc Paymt FiSick Leave 335304530
2007 10100 0100 [E123 |Employers Health Insurance 465 554,35
2007 (0100 0100 |E124  |Employers Life Insurance 1,793.04
200711300 13210 |E111  [Regular Salaries And WWages 142 465,94
2007|1300 1320 |E121  |Employers Fica 1037579
2007|1300 1320 |E122  |Emp Ret-Inc Paymt FiSick Leave 10,801 .46
2007 (1300 1320 |E123  |Employers Health Insurance 23762.03
200711300 13210 |E124  |Emplayers Life Insurance 91.14
2007 (1300 132K |ET11  |Regular Salaries And YWages 300,399.75
2007|1300 132K |E121  |Employers Fica 21,385 .49
2007|1300 132K |BE122  |Emp Ret-lnc Paymt F/Sick Leave 23063 .42
200711300 132K |E123 [Employers Health Insurance 46 26372
2007 (1300 132K |E124  |Employers Life Insurance 171.12
2007|3700 3700 |E111 Regular Salaries And Wages 65158 B52.50
2007|3700 3700 |E121  |Employers Fica A04 52659
2007|3700 3700 |E122  |Emp Ret-lnc Paymt FiSick Leave B35 72026
2007 (3700 3700 |E123  |Employers Health Insurance 1,075 023.95
2007|3700 3700 [E124  |Employers Life Insurance 3.5981.26

11) Save your report as Exercise4_Crosstabs—Your Name.
12) To create a crosstab, delete the table from the report.

available to use in the crosstab and then click on Next.

# Select the Yariables
* In Alphabetical Order

(" By Daka Provider

El

Variables

Fiscal Year

Formulas

13) From the menu bar, select Insert > Crosstab and click somewhere inside the Report Panel.
14) Click on Use existing data from the document when the New Crosstab Wizard appears.
15) Select Fund, Fund Type, Object, Posting Amount and Object Name from the list of variables
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16) How you wish to see the data laid out in the crosstab will determine how you decide to Pivot
Data for the Crosstab. For this example, move objects to Columns or Rows as shown below
and click on Finish.

Pivot Data for the Crosstab

Here, wou specify the variables you wank to display in the
columns, rows and body of the crosstab, You can drag and
drop a variable from one Folder to anaother,

& Crosstab Yariables:
_olurnns
Fund Type
Fund
Riows
Chject
¥ Object Mame
Body
Posting Amount

Once you have completed the exercise if you have time, go back and set up the crosstab with Object
and Object Name under Columns and Fund Type and Fund under Rows to analyze the difference that
small change makes to the crosstab report.

Your results should be similar to these:

E111 E121 E122 E123 E124
Regular Salaries A1 Employers Fica Emp Ret-Inc Paymt Employers Health | Employers Life Insi
0100 0100 4 ,366,752.00 312518.43 335,045,530 465 554 .35 1.793.04
1300 132J 142 465 94 1037679 10,801.46 23,762.03 91.14
1300 132K 300,399.75 21,368.49 23068542 46 263.72 171.12
3700 3700 E.8158 B52.58 504 52659 53872026 1075 023.95 3.981.26

17) Insert a Sum to total up the expenditures.
E111 E121 E122 E123 E124

Regqular Salaries A1 Employers Fica Emp Ret-Inc Paymt Employers Health | Employers Life Ins: Sum:
0100 0100 4,366 782.00 F2518.45 33804530 465 554,35 1,793.04 5,484,693.12
1300 132J 142 455.594 10,375.79 10,801.46 2376203 91.14 187,496.36
1300 132K 300 399.75 21,385.49 23 065,42 46,263.72 17112 391,291.50
3700 3700 5,518 B52.55 504 52650 83872026 1,075,023.95 3.981.26 8,940,904.64
Sum: 11,628,300.27 848,809.30 910,635.44 1,610,604.05 6,036.56 15,004,385.62

At this point, you have created a functioning crosstab report. However, there are several things you
may do to break the report down even further or format the report differently.
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18) Insert a Break = on Fund Type by clicking in the Fund Type column and then clicking on
Insert Break. Breaks will be covered in the following chapter.

19) Remove the Sum you inserted and re-insert the Sum so that you can get totals for the Fund

Type breakdown.

E111 E121 E122 E123 E124
Regular Salaries A1 Employers Fica Emp Ret.Inc Paymt Employers Health | Employers Life Insi Sum:
0100 0100 4,366,782.00 32,518.43 336,045.30 455 554,35 179304  5484,693.12
0100 | Sum: 4,366,782.00 312,518.43 338,045.30 465,554.35 1,793.04|  5484,693.12
142 465 94 10,375.79 10,801 46 2376203 9114 187,496.36
300,399 75 21,388 49 23 067 42 46,263 72 17112 391,291.50
1300 | Sum: 442,865.69 31,764.28 33,869.88 70,025.75 262.26 578,787.86
3700 3700 B 818 B52 58 £04 525 59 £33 720 26 1075 023 95 398126 8,940,904.64
3700 | Sum: 6,818,652.58 504,526.59 538,720.26 1,075,023.95 3,981.26)  8,940,904.64
| | Sum:| 11,628,300.27 | 848,809.30 | 910,635.44 | 1,610,604.05 | 6,036.56 |15.004.385 62

20) Apply the formatting skills and, using what you have learned about formulas and variables,
experiment with this crosstab report by making it more appealing. The image below is an
example of what a finalized report using a crosstab would look like.

Personal Costs By Fund Type and Fund for Fiscal Year 2007

E111 E121 E122 E123 E124
el Emp RetInc ) .
Eegulall Salaries Employers Fica Paymt F/Sick Emplﬁoyels Health Emplﬁoyels Life Grand Total:
nd Wages Leave Insurance Insurance

0100 |l]1l]l] 4 366 ,752.00 312 5158.43 3358,045.30 465 554,35 1,793.04 5,484,693.12
Total for Fund Type 0100 4,366,782.00 312,518.43 338,045.30 465,554.35 1,793.04 5,484,693.12
1300 [132J 142 465.94 10,375.79 10,801.46 23762.03 91.14 187,496.36
132K 300,399.75 21.388.49 23,065.42 46 263.72 171.12 391,291.50
Total for Fund Type 1300 442,865.69 31,764.28 33,869.88 70,025.75 262.26 578,787.86
3700 |3?0l] 5,813 55258 504 526.59 5358,720.26 1,075 023.95 3.981.26 8,940,904.64
Total for Fund Type 3700 6,818,652.58 504,526.59 538,720.26 1.075,023.95 3,981.26 8,940,904 .64
Grand Total: 11,628,300.27 848,809.30 910,635.44 1,610,604.05 6.036.56] 15,004,385.62]

21) Save your report.
22) Close your report.
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Chapter 8: Sections

How to Create Sections

Adding sections to group data helps to add organization to reports. To make reports easy to navigate,
you may divide the report into sections that group related data together. The tables in a section only
display the data relevant to the Dimens